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About CADtools 4

Welcome to Hot Door CADtools, a full-featured

CAD plug-in for Adobe Illustrator 10, CS or CS2.
CADtools offers aneasy and elegant solution for
designers who need the precision of CAD within the
flexible, creative environment of Adobe Illustrator.

Core features of CADtools 4

¢ Precision drawing tools for 2D and isometric
or axonometric objects

e Standard or custom scale defined per document
or per Illustrator layer

e Scaled snapping CADgrids and CADrulers

e On-screen info while dragging objects in scale
e Live dimensions link to objects and respond
to artwork changes

Dimensions show measurement or custom text
Instant dimensioning of document or objects
International number format support

Dual dimensioning and tolerancing

Chain and datum dimension tools
Auto-labeling with increments or custom text
Wall creation tool with sliding editability
Custom dimension and label styles

Path division for cutting or marking any path
Palette controls allow live editing of objects,
dimension styles, scale, etc.

¢ Scaled move, transform and repeat

e Instant calculation of area, perimeter, length
of any path or set of paths

e Measure Scale tool - similar to a map's scale

e Smart Trim and Extend tools

What's new in CADtools 4

e Instant dimensioning of document or objects

e New wall tool with sliding editability and

live on-screen info while dragging

e Dimensions can be edited with values preserved
¢ Dimensions can show measurement or

custom text

e Dimension line spacing can be adjusted

Path divide marks or cuts paths into equal parts
Improved fillet and chamfer tools

New Illustrator CS2 compatibility



Behind the concept

Hot Door, Inc. (metaphorical for 'exciting opportunity')

was formed in 1996 around a product concept that

bridged CAD and Adobe Illustrator. Our lead developer
Brendon Cheves conceived the idea while teaching students
how to use Adobe Illustrator to present their CAD files in a
university classroom. After much research in the technical
design field, CADtools 1 was developed and released in 1997.
With the support of Adobe Solutions Network and
thousands of happy customers, CADtools 2 was carefully
crafted and released in 1999 with live drawing and
dimensioning features and a palette-based interface.

Hot Door subsequently released other Illustrator plugin
products including the popular Transparency, MultiPage,

and Perspective plugins for Illustrator. CADtools 3 shipped
in 2003, marking a new phase of product evolution with
innovative isometric drawing and dimensioning features and
refined dimension control. Since then, we have added other
complementary products such as Code Zebra Symbols and the
CADpatterns library to simplify projects within Illustrator.

CADtools 4 polishes the broad range of tools and functions
that now rival major CAD programs. On a larger scale,
dimensions can now be applied instantly to an entire
document. On a smaller scale, any path can be marked and
divided into equal parts. The new improved wall tool offers
on-screen data during creation and elegant sliding control
during editing. Customers will be pleased with the new
editable dimensions that preserve their text or numeric
values. Even dimensions and labels are more adjustable in
appearance. CADtools continues to grow with Adobe
Illustrator to make work easier and enjoyable for design
professionals around the world.

Our customers determine the design and direction of

our products, and we promise complete satisfaction with

a 90-day money-back guarantee. Our customer service is
unmatched, and we welcome your calls and emails every day.
Please don't hesitate to ask questions or provide comments
on our products - we look forward to hearing from you!

Shari Cheves, President

Brendon Cheves & Jeff Winters
Lead Software Engineers

Updating or installing CADtools

UPDATING from CADtools 3 on
Macintosh or Windows

1. If you are currently running Adobe Illustrator,
quit the application.

2. Double-click Install Hot Door CADtools. Follow
the on-screen instructions to install the file named
CADtools.aip into Adobe Illustrator > Plug-ins >
Tools folder. Your old version will be replaced.

3. When you launch the Adobe Illustrator
application again, a CADtools Personalization dialog
will appear. Enter the new CADtools 4 upgrade serial
number and then enter the CADtools 3 serial number
when prompted.

4. If you plan to use Illustrator CS or CS2 with older
CADtools files generated with Illustrator 10, please
follow instructions in the next section "Converting
CADtools files with Legacy Text."

FULL VERSION of CADtools 4 on
Macintosh or Windows

1. If you are currently running Adobe Illustrator,
quit the application.

2. Double-click Install Hot Door CADtools. Follow
the on-screen instructions to install the file named
CADtools into Adobe Illustrator > Plug-ins > Tools
folder.

3. When you launch the Adobe Illustrator
application again, the CADtools Personalization
dialog will request your name and serial number.

Hot Tip!

If you ever need to reinstall CADtools, just download
the demo version from the CADtools > Demos section
of the Hot Door Web site at www.hotdoor.com.



Personalizing, registration and support

CADtools Personalization

Please activate Hot Door CADtools 4:

Name: | |

Company: | |

Serial number: || |

(Demo:) ( Purchase ) @

Personalization:

If you have purchased a full version of CADtools 4, enter your
CADtools serial number (with a format XXXX-X-X-XXX-XXX-
XXXXX) and click OK. Illustrator will open and you will see
some of the tools belonging to CADtools in the toolbox. The
CADtools icons have red point markings.

If you wish to use the demo version of CADtools, click the
Demo button. CADtools will function for an unlimited time
period but limits your drawing and dimensioning to 1:3 scale

with access to only the top tool in each of the six tool groups.

If you wish to purchase the full version of CADtools, click the
Purchase button to automatically launch the Hot Door Web
site and online store.

Registration:

To be eligible for free technical support, information

on upgrades, and other special offers, please register your
copy of CADtools online at:

http://www.hotdoor.com

(if you purchased CADtools directly from Hot Door, you are
already registered)

Technical support online:
As a registered user, you are entitled to free email or
phone technical support.

Online detailed FAQ, technical support, and tutorial:
Visit http://www.hotdoor.com to access the CADtools page.

Technical support by phone: 949-464-0300
Phone inquiries are always welcome and service is prompt and
professional.

Converting older CADtools files

Converting CADtools files created with Legacy Text
(Illustrator 10 or earlier)

To properly convert an Illustrator 10 file containing
CADtools dimensions to Illustrator CS or Illustrator CS2,
first open the file in CS2. Do NOT click Update when
prompted. Click OK.

This file contains text that was created in a
previous version of lllustrator. This legacy text

L%y must be updated before you can edit it.

» Choose Update to update all of the legacy text now.
+ Choose OK to update the text later.
» Choose Cancel to cancel opening the file.

{ Update ) (" cancel ) @

Once the file is opened, click Update links in the
CADstyle palette. Then save the file in CS or CS2 format.
Close the file. Open the file again and click Update
when prompted. This process converts Legacy dimension
text separately from Legacy Illustrator text for

best results.

Converting CADtools files to preserve scales and
live dimensions (CADtools 2 or 3)

Files created with older versions of CADtools can be
opened with live dimensions and scale data. Click
Convert when opening to retain the information.
However, some dimensions may change if they were
modified without the CADtools palettes or tools.

If this is a problem, reopen the files without scale data
or live dimensions by clicking Do Not Convert.

CADtools 4 can convert older CADtools scales and
. dimensions so they remain live. This is
b recommended, but may change some dimensions if
——  they were modified.

See the CADtools FAQ at hotdoor.com for complete
details of the conversion process.

( Do Not Convert :) (-Cunvert )
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Overview of the CADtools interface

Finding the tools

After you have properly installed CADtools and
launched Adobe Illustrator, you will notice new CAD-
tools drawing and dimensioning tools in the toolbox
of Adobe Illustrator. In addition to the six new tools
you see in the toolbox, there are many popout tools.
Select the small arrows on the right of the tool icons
and drag to highlight other tools. The six different
tool groups can be separated by dragging the tearoff
icon at the end of each set of hidden tools.

Color icons and tool behavior

CADtools icons are distinguished by their red point
markings. The red points indicate the position of
mouse-click(s) in relationship to the artwork created.
Tool icons which have only one red point require only
one mouse-click-and-drag - except for the object cen-
ter tool, which requires only one mouse-click on an
object. Tool icons which have two red points require
two mouse-clicks positioned on artwork as shown in
the icon. For most of these tools, you must drag the

mouse after the second click. The fillet, chamfer, trim,

and extend tools do not require dragging after the
second click.

CADtools automatic dimensioning features

CADtools features automatic dimensioning of
selected objects or all objects on the document.

After setting the desired scale with the CADdocument
palette, Choose Window > CADtools > Auto

Dimension Selection or Auto Dimension Document.

Hot Tip!

The CADtools icons all contain red points which
indicate the number and placement of mouse-clicks
required to properly use the tool.

Overview of the CADtools interface (cont.)

Finding the palettes

The eight palettes in CADtools are essential for
controlling the appearance and creation of CAD
artwork. To view and select one of these palettes,
choose Window > CADtools. Refer to the list below
for the names of the palettes and their functions.

CADdocument

CADguides

CADisometric

CADlabels

CADstyles

CADtext

CADtracker

CADwalls

Hot Tip!

Defines document-wide
settings such as numeric
input and scale

Allows CADgrid and CADruler
control in scale

Controls isometric/axonometric
angles and allows one-click
projection and flattening of
artwork between 2D and isometric
views

Sets the appearance of labels and
increments for automatic labeling

Sets the appearance of
dimensions, including size of
arrowheads and witness lines

Controls the text options for
all CADtools dimensions and
labels

Displays geometric data for
CADtools artwork (including
location, length, perimeter, and
area), transforms objects in scale,
moves objects in scale, and repeats
objects in scale

Sets the thickness of walls and
how they are measured (from
inside, center or outside)

To dock a palette, drag the palette tab of one palette to
the bottom of another palette.
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Setting up the document: CADdocument

Before working with CADtools, it's important to use
the CADdocument palette to define specific settings
which affect the entire document - including scale
by document or layer. The CADdocument palette also
controls the units and precision for numeric input

default values.
(4] 0

J CADdocument \Cﬁ.ﬂguldes \ @

General

Mumber format: @ 1,234.56 P-‘B

2 Use thousands separator

E Create and use dimensicn layer

E Create live dimensions

Numeric input

Units: [ " (dacimall H,‘i
Precision: | 0.000 s
Scale

C Document-based 8 Layer-based

v

Scale: [ 1/47=1' I—"-i

Layer 2 - 1/4" = 1"
Layer 1 - 1:1

e Set custom scales with this
popup menu (see info on scale)

e Comma or decimal number format
applies to all dimension text

e The thousands separator shows the
comma in dimension numbers

e A dimension layer keeps your dimensions
separate from other artwork

e Live dimensions will auto-update with
changes in scale or appearance

e Set default units and precision for
numeric input when using tools in CAD-
tools. (You can always input your own
units and override the default settings.)

e Set level of precision for numeric
input.

® Choose Document-based scale for
one scale on the entire document.
Choose Layer-based scale to set
unique scales per layer. When using
scale, you can draw objects larger or
smaller than actual size using a ratio
of measurement. For example, if your
scale is set to 1” = 1, then an object
1” in length would dimension as 12”
or 1" in length using CADtools.

Note about live dimensions: Dimensions that have been
created with 'Create live dimensions' checked will automatically
update with changes in scale and appearance. Dimensions that
have been created with this option unchecked cannot ever be
live. To automatically unlink the dimensions from their objects,
ungroup the dimensions. Always ungroup dimensions prior to
copying them into new documents. If you need to duplicate
an object with live dimensions, copy and paste the object with
its dimensions rather than option-dragging them.

Setting up the document: Scale

Using CADdocument and scale

To change a layer or document scale, use the Scale
popup menu in the CADdocument palette. Choose

a scale from the three sections of presets: custom,
engineering, and architectural scales.

To set a custom scale, choose Add Custom Scale...
from the popout menu in the CADdocument palette.
Enter values on each side of the “scale equation”
in Absolute or Ratio format. Architectural scales
are typically expressed in Absolute format and
engineering scales are typically expressed in Ratio
format. Choose independent CADtools units from
the popup menus for each side of the Absolute
equation. Use any number of digits in the fields.
Add a space between digits representing feet and
inches (ex: 1' 2 1/2") You can add up to 5 custom
scales to the custom scale menu.

Set Custom Scale

® Absolute: f oK
T in #= L B roven

O Ratio:

To delete a custom scale, first select the scale and
then choose Remove Custom Scale from the popup
menu in the CADdocument palette.

Note about drawing with scale: Since scale
affects only CADtools drawing, editing, labeling
and dimensioning tools, remember to use the
CADrulers, CADgrids, and CADtracker to monitor
your values in scale. Object artwork is not affected
by changes in scale - only dimensions and measure-
ments are affected by scale. Changing scale

does not resize artwork.

13
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Setting up the document: CADguides

CADguides establishes special grid and ruler settings for
use with CADtools. The origin for CADrulers is defined by
the Illustrator's ruler origin. If you plan to use isometric
drawing and dimensioning tools, choose Isometric grid

lines to preview the grid according to the settings in the

CADisometric palette.

Q0

| CADguides )

W showgrid [ Show rulers

Grids

Lines: | Flat  [ig) . Light Blue |3
E Snap to grid Tolerance: |2 pt
Rulers

Units: | * {decimal) 4 ) ¥ Append
Pracision: | 0.000 }%]

T | myriad-Roman I%J

e Show grid and Show rulers display
special scaled grids and rulers for use
with CADtools

® Choose flat or isometric grid lines

e Change the grid color with the pop-
up menu, and choose Other... to open
the system level color picker for
additional choices

® Snap to grid to snap the cursor to
grid lines and intersections while
using CADtools drawing tools; enter a
value for snapping tolerance

® Units and precision settings are
unique for CADrulers; append will add
the unit label in the CADrulers

e Change the CADrulers font with the
popup menu

Hot Tip! Adobe Illustrator includes Smart Guides that help
you create, align, edit, and transform objects. Choose Illus-
trator > View > Smart Guides. The Illustrator Smart Guides
work with CADtracker, CADgrids and CADrulers for optimal

precision and control when manipulating artwork.

2D CAD drawing tools

Once you've set up your document settings, you can use
Use CAD 2D drawing tools to create flat objects in scale by
drawing or clicking for numeric input with these units:

Points: pt

Picas: p

Millimeters: mm

Centimeters: cm

Meters: m

Kilometers: km

Decimal inches with symbol: X.X“

Fractional inches with symbol: X X/X”

Decimal inches with units: X.X in

Fractional inches with units: X X/X in

Decimal feet and inches with symbol: X' X.X“
Fractional feet and inches with symbol: X' X/X*
Decimal feet and inches with units: X ft X.X in
Fractional feet and inches with units: X ft X/X in
Miles: mi

&)

olm|O@| a5 NNy (R

Orthographic drawing tool group:

Click once on the document to input values numerically
CAD Rectangle - Click and drag to create the shape.
CAD Centered Rectangle - Click and drag.

CAD Ellipse - Click and drag to create the shape.

CAD Centered Ellipse - Click and drag.

CAD Arc by Radius - Click origin point, then click and
drag another point to define the endpoint and radius
of the arc. Click the second point without dragging to
input values numerically.

CAD Arc by Points - Click origin point, then click and
drag another point to define the endpoints and curva-
ture of the arc. Click the second point without drag-
ging to input values numerically.

CAD Line - Click and drag to create the line. Click and
drag from the endpoint of a line path to continue the
line. Shift-alt/option drag to create isometric lines.
Shift-drag to constrain to 45° angles.

Add Wall - Click and drag on the side or end of a wall
to create a new wall.

Remove Wall - Click a wall that is free of dependent
walls to remove it.

Move Wall - Click and drag a wall to adjust its location.
View all relative wall sizes in the red change boxes.

15
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2D CAD drawing tools (cont.)

CAD Rectangle

Select the CAD Rectangle tool and position the cur-
sor where you want a corner of the rectangle to ap-
pear. Click and drag from one edge of the rectangle
to the opposite edge. Hold down the shift key while
dragging to create a square.

Note: To quickly toggle between the Rectangle and
Centered Rectangle, use the alt/option key. To
numerically create a rectangle in scale, click once
with the CAD Rectangle or Centered Rectangle tool.

CAD Centered rectangle

Select the CAD Centered Rectangle tool and po-
sition the cursor where you want a corner of the
rectangle to appear. Click and drag from the center
of the rectangle to the edge. Hold down the shift
key while dragging to create a square.

CAD Ellipse

Select the CAD Ellipse tool and position the cursor
where you want a corner of the ellipse to appear.
Click and drag from one edge of the ellipse to the
opposite edge. Hold down the shift key while
dragging to create a circle.

Note: To quickly toggle between Ellipse and

Centered ellipse, use the alt/option key. To
numerically create an ellipse in scale, click once with
the CAD Ellipse or Centered Ellipse tool.

CAD Centered Ellipse

Select the CAD Centered Ellipse tool and position
the cursor where you want a center of the ellipse
to appear. Click and drag from the center of the
ellipse to the edge. Hold down the shift key while
dragging to create a circle.

first then sec-

click ond click

once and drag
counter-
clockwise

L

: £

first ! second

click v click then

and drag drag back
and forth

2D CAD drawing tools (cont.)

CAD Arc (by Radius)

Select the CAD Arc (by Radius) tool and position
the cursor where you want the center of the arc.
Click the mouse button once and release the mouse
button. Then position the cursor where you want
the arc to begin, which will be the length of the arc
radius. Click and drag counterclockwise to create the
arc. Hold down the control key while you are drag-
ging to create the opposite angle.

Note: To quickly toggle between Arc (by Radius) and
Arc (by Points), use the alt/option key. To numeri-
cally create an arc (by radius) to scale:

1) Click once where you want the arc to begin

2) Click once anywhere on the document

3) Enter the values and units for the arc

CAD Arc (by Points)

Select the CAD Arc (by Points) tool and position the
cursor where you want the arc to begin. If this is an
anchor point, the cursor will change to ( =i, ). Click
the mouse button once and release the mouse but-
ton. Position the cursor where you want the arc to
end. Click and drag back and forth to create the arc.
Hold down the control key while you are dragging to
create the opposite arc.

To numerically create an arc (by points) to scale:
1) Click once where you want the arc to begin

2) Click once where you want the arc to end

3) Enter the values and units for the arc radius
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2D CAD drawing tools (cont.)

CAD Line

The CAD Line tool allows you to see the line "
while you are dragging to create it and join it to
other lines. Using the CADgrids, CADrulers, and

CADtracker palette, you can precisely control the first click
line size and placement. and drag

A0

Select the line tool and position the cursor
where you want the beginning of the line
to appear. Click and drag to position the line,
then release the mouse button to create the
line. Hold down the shift key while dragging to ~%~ _ _

constrain the tool to multiples of 45°. ~~

release mouse
button, click
endpoint, then
drag - continue

For isometric lines, hold down the shift+alt/
option keys while dragging to constrain the tool
to the current isometric angle. Isometric lines will

not automatically update with changes to the and close the path
. L. y up g ) . by clicking on the
isometric view. Be sure to set up your isometric first point

view angles with the CADisometric palette before

creating isometric artwork with the CAD Line tool.

To create polygons with the line tool, create a
line, then position your mouse over an endpoint
of the line. When the ( -j5 ) cursor appears, begin
dragging to create a new line joined at that end-
point. Release the mouse button when you have
positioned the line and continue the process as
needed. If you want to close the path, click and
drag the final line until the cursor is over the first
anchor point of the polygon. When the (k)
cursor appears, release the mouse button and the
polygon will close itself.

Note about numeric input: To numerically create
a line in scale, click once on the document with the
CAD Line tool.

1 first click

1 and drag
1

|

release mouse
button, click
endpoint,
then drag

2D CAD drawing tools (cont.)

Add wall

The Add Wall tool works like the CAD Line tool,
creating rectangles (representing walls) with a
thickness defined in the CADwalls palette numeric
input dialog box. Before drawing walls, open the
CADwalls palette and set the wall thickness and
measurement reference.

If you have selected measure to the inside,
additional wall segments will be joined like this:

If you have selected measure to the middle,
additional wall segments will be joined like this:

If you have selected measure to the outside,
additional wall segments will be joined like this:

h

Click and drag on the document or click once to
access the numeric input dialog box to numerically
create walls in scale.

19
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2D CAD drawing tools (cont.)

Add Wall (cont.)

To draw a wall, select the Add Wall tool and
position the cursor where you want the end of the
wall to appear. Click and drag to position the wall.
Release the mouse button to create it. Hold down
the shift key while dragging to constrain the wall
to 45° increments. Hold down the alt/option key
while dragging to snap the wall to the nearest
unit increment.

To view wall measurements while dragging, make
sure you have checked Show info while dragging in
the CADtracker palette.

To create an additional wall joined to the end or
side of an existing wall, position the cursor over
the wall path at the desired location until the
(. ) cursor appears. Then click on the path of
the wall and begin dragging. Release the mouse
button to complete the new wall addition. Walls
can only be added when this cursor appears to
show that you are over a wall line.

The Add Wall tool does not create curved walls,
but you can use the Illustrator Offset Path com-
mand to simulate curved walls. First draw a curved
path and then select it. From the Illustrator menu,
choose Effect > Path > Offset Path... to adjust the
appearance of the offset.

Remove Wall

To remove a wall, select the Remove Wall tools
and position the cursor over the path of the wall
that you want to remove. When the ( & ) cursor
appears, click to remove the wall extension. Note:
Walls can only be removed if they are not joined to
any dependent wall sections.

Hot Tip!

To obtain the area of a space inside walls, use the CAD
Rectangle or Line tool to create a closed shape over the

area. View the area in the CADtracker palette.

2D CAD drawing tools (cont.)

Move Wall

To move a dependent wall along a primary wall,
select the Move Wall tool and position the cursor
over the wall to adjust. Click and drag to slide
the wall along the primary wall to the desired
location.

To view distances between walls while dragging,
make sure you have checked Show info while
moving in the CADwalls palette. Then, while
moving the wall, dimensions will appear in red
boxes that indicate measurements between the
selected wall and other walls along the primary
wall. The units for these measurements are defined
in the last panel of the CADtracker palette.

re- TSR

\ primary wall

\ dependent wall

80068
CADwalls

Maasure walls to: [ Middle |-¢-]

Thickness: | & 000"

E Show info while moving
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Dimensioning control: CADtext

Before dimensioning your objects, open the CADtext palette

to define text attributes for CADtools dimensions and labels.
Use the icon buttons to set the placement of text within the
dimensions. Set the format of dimensions to measurement,
incremental, or custom text. Dual dimensions can also be

set and adjusted separately. To change the text attributes of
live dimensions after they are created, select them and make
changes in the CADtext palette. You can edit the value of any
dimension with the Illustrator Type tool and it will retain
the edited value as custom text.

806
CADtext

B [ Myriad Ro... 5 T EIE pt
BB

E Sliding text  Space: =
Tight Loose

Text distance above line: |4.5 | pt

e Dimension font and size are set
(¥) with the popup menu

& ® Use the icons to set the location
of dimension text inline or above line
T[T ’"I ]}: . for horizontal, vertical, and inclined
L+ dimensions; enter value for text dis-
tance above the dimension line (see
sample on next page)

e Check Sliding text to adjust the
placement of the dimension inside

the dimension line while draggin
z Iso text draws flat E Mave large taxt 99mg

E Flace @ &R Befare g‘ dimension

Farmat:

e Adjust the spacing between the
dimension line and text with the
Space slider

ABC Incremental
123 Incremental
Custom taxt |

e Choose to move larger dimension
Linits: Append text outside of crowded dimension
Precision: | 0.000 B"‘ line areas

e Diameter or radius symbols can
E Tolerance: = |-1 23 | z Shift g

appear before or after dimension text
—Lower: ® Use Measurement Format for
= standard numeric measurement of
Units: | €m I E i E Append artwork, ABC or 123 Incremental for
dimensioning with incremental text
[ - ’
Precision: | -0.000 I i I or Custom text for dimensions
E Tolerance: = |.125 |: Shift

e Choose to show Isometric text as flat
or projected with artwork

displaying customizable text.

e Check dual dimensions as needed -
if this is unchecked, use 'Upper’
menu choices to set single dimen-
sion units, precision and tolerance.

® Units, precision and tolerance
settings are unique for upper and
lower dual dimensions

Dimensioning control: CADstyle

CADstyle helps you customize the appearance of dimensions.
An Update links button adjusts your dimensions and
reapplies these settings if artwork has been resized or moved.
To change the style of live dimensions after they are created,
select them and make changes in the CADstyle palette.

0006

CADstyle > o
General

. [ Black I—H [ Update links :I
Terminators

AEE EEER

W |1_||:|l' Length: [3 | pt ¢;|1?.5=

Dimension lines

wr: |1 pt  Smap: |27 |pt

Witness lines

Wi |1_||:|r Gap: 4.5 | pt  Ext: |3_||:|l:

Diameter dimensions

E Span circle Leader length: |36 | pt

Datum dimensions

[} Chain datum [ | JIS terminataor

Section lines
E Double section weight E Frime section

Witness lines

Dimension line

|</

e Change the dimension color
with the popup menu, selecting
from presets, the current

fill color, or other color using the
system level picker - for custom
colors, use Fill color

® Update links to apply changes
to live dimensions

e Select from several terminator
types and adjust weight, length,
and angle with field values

e Dimension line weight and snap
tolerance are set with field values

e Use field values to set witness
line weight, extension beyond
dimension line, and gap from
object

e Choose to span diameter
dimensions across the circle
or from the circle center

e Select chain datum for dimen-
sioning segments cumulatively
from a reference point (datum)

® Choose to double the weight or
add the prime symbol to Section
lines (found in the Labeling

tool group)

Appended unit label

Witness line extension

Text distance above line (CADtext)

Dimension lines snap
distance

“ witness line gap
-
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2D dimensioning tools 2D dimensioning tools (cont.)

= Horizontal Dimension (by Line)
B3 b H H H A L 1] R T | ™ B
o o | B D | B | S8 A |::i"\‘l & |'[j |ﬂ"'|% e e}| - The Horizontal Dimension (by Line) tool will
click once dimension horizontal line segments. A line

Orthographic dimensioning tool group:

Horizontal Dimension (by Line) - Click and drag out any horizontal
segment to dimension the horizontal distance between two anchor
points.

Horizontal Dimension (by Points) - Click multiple points anywhere
on the document and drag to dimension their horizontal distances.
Horizontal Datum Dimension - Click a point of origin, then click
multiple points and drag to dimension the horizontal distances from
the origin.

Vertical Dimension (by Line) - Click and drag any vertical segment to
dimension the vertical distance between two anchor points.

Vertical Dimension (by Points) - Click multiple points anywhere on
the document and drag to dimension their vertical distances.

Vertical Datum Dimension - Click a point of origin, then click mul-
tiple points and drag to dimension their vertical distances from the
origin.

Inclined Dimension (by Line) - Click and drag any inclined segment
to dimension the inclined distance between two anchor points.
Inclined Dimension (by Points) - Click multiple points anywhere on
the document and drag to dimension their inclined distances.
Inclined Datum Dimension - Click a point of origin, then click mul-
tiple points and drag to dimension their inclined distances from the
origin.

Angle Dimension - Click a line of origin, then click and drag a
nonparallel line to dimension the angle between the lines.

Arc Length Dimension - Click a point of origin on a circular arc, then
click and drag another point on the same arc to dimension the length
along the arc between the points.

Diameter Dimension - Click and drag a point on a circle to dimension
its diameter.

Radius Dimension - Click and drag a point on a circle to dimension its
radius.

Bézier Curvature Dimension - Click and drag directly over a curved
line to display the radius of the curve at the cursor location.

Tangent Dimension - Click and drag directly over a curved line

to display the tangent of the curve at the cursor location. Use alt/op-
tion key to display the tangent's normal line. Use shift to diplay

the normal and tangent lines. Use control to toggle normal placement.
Center line - Click and drag to create the line.

Object center - Click on an object line to mark the center of its
bounding box.

on a line segment

and drag

A

R

%

"
=
-

click on multiple
points and drag

A

click on corner
points, not lines,
when dimension-
ing by points

A

r_di

segment is a path between two anchor points
in Illustrator.

Select the Horizontal Dimension (by Line) tool

and position the cursor over the line you want to
dimension. When the ( =iz ) cursor appears, click the
horizontal line and drag to position the dimension
line. Hold down the shift key while dragging to offset
the horizontal dimension line in increments. The
offset increment value is set in the Snap field in the
Dimension Lines panel of the CADstyle palette.

Note: To quickly toggle between Horizontal Dimension
(by Line) and Vertical Dimension (by Line), use the
alt/option key.

Horizontal Dimension (by Points)

The Horizontal Dimension (by Points) tool will dimen-
sion the horizontal distance between multiple points.
You can define the location of these points anywhere
on your document.

Select the Horizontal Dimension (by Points) tool

and position the cursor at one end of the horizontal
distance you want to dimension. If this is an anchor
point, the cursor will change to ( -i5. ) . Then click
the mouse button once and release the mouse but-
ton. Position the cursor at the next point along the
horizontal distance you want to dimension. Continue
clicking on points along the horizontal distance until
you have reached the last point to dimension. Then
click the last point and drag to position the dimen-
sion line. Use the shift key while dragging to place
the dimension line at a set distance from the object.
The offset increment value is set in the Snap field in
the Dimension lines panel of the CADstyle palette.

Note about changing tools: To quickly toggle between

Horizontal Dimension (by Points) and Vertical Dimen-
sion (by Points), use the alt/option key.
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2D dimensioning tools (cont.)

Horizontal Datum Dimension

The Horizontal Datum Dimension tool will
dimension the horizontal distances between
a point of origin and other points. You can
define the location of these points anywhere
on your document.

Select the Horizontal Datum Dimension tool

and position the cursor at the origin on one

end of the horizontal distance you want to
dimension. If this is an anchor point, the cursor
will change to (-i5. ) . Then click the mouse
button once and release the mouse button.
Position the cursor at the next point along the
horizontal distance you want to dimension.
Continue clicking on points along the horizontal
distance until you have reached the last point to
dimension. Then click the last point and drag to
position the dimension line. Use the shift key
while dragging to place the dimension line at a
set distance from the object. The offset increment
value is set in the Snap field in the Dimension
lines panel of the CADstyle palette.

To make a datum dimension line appear as a linear
chain of dimensions rather than stacked dimensions,
check Chain datum in the CADstyle palette.

1

:

To change the datum dimension terminator to a JIS
terminator, check Chain datum and JIS terminator in
the CADstyle palette.

1.710"
2.A875"
3769

Note about changing tools: To quickly toggle between
Horizontal Datum Dimension and Vertical Datum Dimen-
sion tools, use the alt/option key.

=8
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point of origin
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drag
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click on multiple
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2D dimensioning tools (cont.)

Vertical Dimension (by Line)

The Vertical Dimension (by Line) tool will dimension
vertical line segments. A line segment is a straight
path between two anchor points in Illustrator.

Select the Vertical Dimension (by Line) tool and
position the cursor over the line you want to
dimension. When the ( -i> ) cursor appears, click
the vertical line and drag to position the dimension
line. Hold down the shift key while dragging to
offset the vertical dimension line in increments. The
offset increment value is set in the Snap field in the
Dimension lines panel of the CADstyle palette.

Note about changing tools: To quickly toggle
between Vertical Dimension (by Line) and Horizontal
Dimension (by Line), use the alt/option key.

Vertical Dimension (by Points)

The Vertical Dimension (by Points) tool will
dimension the vertical distance between multiple
points. You can define the location of these
points anywhere on your document.

Select the Vertical Dimension (by Points) tool and
position the cursor at one end of the vertical dis-
tance you want to dimension. If this is an anchor
point, the cursor will change to ( -i5.) . Then click
the mouse button once and release the mouse but-
ton. Position the cursor at the next point along the
vertical distance you want to dimension. Continue
clicking on points along the vertical distance until
you have reached the last point to dimension. Then
click the last point and drag to position the dimen-
sion line. Use the shift key while dragging to place
the dimension line at a set distance from the object.
The offset increment value is set in the Snap field in
the Dimension lines panel of the CADstyle palette.

Note about changing tools: To quickly toggle be-
tween Vertical Dimension (by Points) and Horizontal
Dimension (by Points), use the alt/option key.
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2D dimensioning tools (cont.)

Vertical Datum Dimension

The Vertical Datum Dimension tool will
dimension the vertical distances between a
point of origin and other points. You can
define the location of these points anywhere
on your document.

Select the Vertical Datum Dimension tool and
position the cursor at the origin on one end of

the horizontal distance you want to dimension.

If this is an anchor point, the cursor will change

to ( =iz, ). Then click the mouse button once and
release the mouse button. Position the cursor at the
next point along the vertical distance you want to
dimension. Continue clicking on points along the
vertical distance until you have reached the last
point to dimension. Then click the last point and
drag to position the dimension line. Use the shift
key while dragging to place the dimension line at a
set distance from the object. The offset increment
value is set in the Snap field in the Dimension lines
panel of the CADstyle palette.

To make a datum dimension line appear as a linear
chain of dimensions rather than stacked dimen-
sions, check Chain datum in the CADstyle palette.

To change the datum dimension terminator to
a JIS terminator, check Chain datum and JIS
terminator in the CADstyle palette.

Note about changing tools: To quickly toggle
between Vertical Datum Dimension and Horizontal
Datum Dimension tools, use the alt/option key.

1l

click on a
point of origin

click
multiple
points and
drag

&

click once

on a line segment

and drag

4

7

<

click on multiple

points and drag

N

2D dimensioning tools (cont.)

Inclined Dimension (by Line)

The Inclined Dimension (by Line) tool will
dimension angled or “inclined” line segments.
A line segment is a straight path between two
anchor points in Illustrator.

Select the Inclined Dimension (by Line) tool

and position the cursor over the inclined line
you want to dimension. When the ( -j> ) cursor
appears, click the line and drag to position the
dimension line. Use the shift key while dragging
to place the dimension line at a set distance
from the object. The offset increment value is set
in the Snap field in the Dimension lines panel of
the CADstyle palette.

Inclined Dimension (by Points)

The Inclined Dimension (by Points) tool will
dimension the inclined, absolute distance be-
tween multiple points along any axis. You can
define the location of these points anywhere on
your document.

Select the Inclined Dimension (by Points) tool
and position the cursor at one end of the in-
clined distance you want to dimension. If this is
an anchor point, the cursor will change to

( -i7. ). Then click the mouse button once and
release the mouse button. Position the cursor at
the opposite end of the inclined distance you
want to dimension. If this is an anchor point,
the cursor will change to ( -i ). Then click and
drag to position the dimension line. Use the
shift key while dragging to place the dimension
line at a set distance from the object. The offset
increment value is set in the Snap field in the
Dimension lines panel of the CADstyle palette.

Note about dimensioning on inclines:

To prevent errors in measuring nonlinear inclined
segments, the inclined chain dimension tool will
only measure multiple segments contained within
a reasonable angle.
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2D dimensioning tools (cont.)

Inclined Datum Dimension

The Inclined Datum Dimension tool will
dimension the inclined distances between

a point of origin and other points. You can
define the location of these points anywhere on
your document.

Select the Inclined Datum Dimension tool and
position the cursor at the origin on one end of

the inclined distance you want to dimension.

If this is an anchor point, the cursor will change

to ( -i7. ). Then click the mouse button once and
release the mouse button. Position the cursor at the
next point along the inclined distance you want to
dimension. Continue clicking on points along the
inclined distance until you have reached the last
point to dimension. Then click the last point and
drag to position the dimension line. Use the shift
key while dragging to place the dimension line at a
set distance from the object. The offset increment
value is set in the Snap field in the Dimension lines
panel of the CADstyle palette.

To make a datum dimension line appear as a linear
chain of dimensions rather than stacked dimen-
sions, check Chain datum in the CADstyle palette.

To change the datum dimension terminator to
a JIS terminator, check Chain datum and JIS
terminator in the CADstyle palette.

Note about dimensioning on inclines:

To prevent errors in measuring nonlinear inclined
segments, the inclined chain dimension tool will
only measure multiple segments contained within a
reasonable angle.
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2D dimensioning tools (cont.)

Angle Dimension

The Angle Dimension tool will dimension the angle
between any two nonparallel lines. Position the
cursor over the first line. When the ( -iz ) cursor
appears, click anywhere on the line and release
the mouse button. Then position the cursor over
the second line. When the ( ;i ) cursor appears,
click anywhere on the line and drag to position
the angle dimension line. Hold down the control
key while dragging to dimension the opposite
angle. Hold down the alt/option key while you are
dragging to remove witness lines.

Arc Length Dimension

The Arc Length Dimension tool will dimension the
length of a circular arc or circle defined by any
two points on the circular arc or circle. Position
the cursor over the arc or circle where the arc
length dimension will begin. When the (-}~ ) or

( -iz.) cursor appears, click once on the arc or
circle. Then position the cursor over the arc or
circle where the arc length dimension will end.
When the (;i- ) or ( ;s ) cursor appears, click
on the arc and drag to position the arc length di-
mension line. Hold down the control key while you
ate dragging to dimension the opposite arc length.

Note about dimensioning lengths along curves:
The Arc Length Dimension tool works only on
circular arcs or circles. To retrieve the length
between two points along a Bezier curve, copy the
segment with the direct selection tool, paste, and
use the CADtracker palette to view the length of the
Bezier segment in scale. If necessary, use the Il-
lustrator Add Anchor Point tool to add points along
the Bezier curve for measuring.
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2D dimensioning tools (cont.)

Diameter Dimension
Select the Diameter Dimension tool and position
the cursor over the path of a circle. When the
-iz ) cursor appears, click and drag to position
the diameter dimension. Hold down the shift
key while dragging to constrain the tool to mul-
tiples of 45°. Hold down the control key while
you are dragging to toggle the placement of the
diameter dimension text.

Radius Dimension

Select the Radius Dimension tool and position
the cursor over the path of a circle. When the

( =iz ) cursor appears, click and drag to position
the radius dimension. Hold down the shift key
while dragging to constrain the tool to multiples
of 45°. Hold down the control key while you are
dragging to toggle the placement of the radius
dimension text.

Note about changing tools: To quickly toggle
between radius dimension and diameter dimen-
sion, use the alt/option key.

To dimension the radius of arcs, use the Bézier
Curvature Dimension tool.
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2D dimensioning tools (cont.)

Bézier Curvature Dimension

The Bézier Curvature Dimension tool will auto-
matically display the radius at any point on a
Bézier curve. Select the Bézier Curvature Dimen-
sion tool and position the cursor directly over

a Bézier curve. When the ( -E; ) cursor appears,
click and drag along the Bézier curve. While you
are dragging along the curved path, you will see
a radius and its arc at every point. To create the
Bézier curvature dimension at any point, release
the mouse button at that point. To hide the arc,
hold down the control key while dragging.

Note about the tool limitations: Circles and arcs
created within Illustrator are constructed with
Bézier curves. The approximation of their radius
may reveal up to 5% difference in value using the
Bézier Curvature Dimension tool.

Tangent Dimension

The Tangent Dimension tool will automatically
display the tangent line at any point along on a
Bézier curve. Select the Tangent Dimension tool
and position the cursor directly over a Bézier
curve. When the ( -i> ) cursor appears, click and
drag along the Bézier curve. While you are drag-
ging along the curved path, you will see a tan-
gent line at every point. To create the tangent
line, release the mouse button at that point. Use
alt/option key to display the tangent's normal.
Use shift to diplay the normal and tangent lines.
Use control to toggle normal placement.

Hot Tip!

To dimension type, convert type to outlines with the
Create Outlines command in Adobe Illustrator. Or use
the dimension by points tools to measure between
any points on the document.
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2D dimensioning tools (cont.)

Center Line

The Center Line tool will allow you to create a cen-
ter line on your document. Select the Center Line
tool and position the cursor where you want the
beginning of the line to appear. Click and drag to
position the line, then release the mouse button to
create the line. Hold down the shift key while drag-
ging to constrain the tool to multiples of 45°.

Hot Tip!

To place a center line over a shape, first click the ob-
Jject with the circle center tool. Then select the center
line tool and drag over one of the circle center lines.

Object Center

Select the Object Center tool and position the cursor
over the path of an object. When the (-i-) cursor
appears, click once and release the mouse button.

Use the object center tool to find the center of any
shape or path. The center is determined by the
invisible bounding box enclosing the artwork.
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Automatic Dimensioning

Automatically dimension objects with horizontal,
vertical, inclined, and diameter/radius dimensions
by selecting the object(s) and choosing Window >
CADtools > Auto Dimension Selection. Dimension
all objects on the document by selecting Auto
Dimension Document.

Transform irFs

Transparency {r 3 F10
Type >
Variables

Show CADdocument
Show CADguides

»
Brush Libraries * | Show CADisometric
Graphic Style Libraries > Show CADlabels
»
>

CADtools

Swatch Libraries Show CADstyle

Symbol Libraries Show CADtext

« Untitled-3 @ 100% (CMYK/Preview) } Show CADtracker
Show CADwalls

|
Auto Dimension Selection |,

Auto Dimension Document

Labeling: CADlabels palette

CADlabels offers many options for adjusting the
appearance of labels. For incremental labels, set the
letter or number that the next label will display.
Choose a tight or loose distance for label borders.
Remember to check "Create live dimensions" in the
CADdocument palette if you want to create CADtools
artwork that can later be modified in appearance.

[+ NN =]
CAaDlabels

dd A B
Leader length: I?‘pr

Format:| Custom text I—:] Next
Border: =

Tight Loose
&)

o I L S e

Labeling tool group:

Label tool - Click and drag to create a label

using the format settings in the CADlabels

palette - ABC incremental, 123 incremental, or
Custom text. If Custom text is selected, labels will be
created with default text "Custom" highlighted for
easy editing.

Datum feature - Click and drag to create the label.
Datum target - Click and drag to create the label.
Datum flag - Click and drag to create the label.
Revision bubble - Click an object line, or click and
drag to create the label.

Section line - Click and drag to create the line. Use
the CADstyle palette to make the section line double
weight and appear with the prime symbol.
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Labeling: Tools
o

AR B E | T

Each CADtools label is automatically linked to a
point created at the base of each label. To adjust
the angle or extension of each label while retaining
the link to its location point, use the CADtools
Dimension Resize tool. If you want to move the
entire label, be sure to select the linked point at
the tip of the arrowhead before moving. To prevent
updating of the label, ungroup the label so

that it will no longer be linked to its original
location point.

Label
The CADlabels palette controls the appearance of
the Label tool with three different formats.

o0
CADIabels > |

- A
Leader length: |36 | pt
Format: Bxt: |ﬁ-.

123 Incremental
Border: Custom taxt

Loose

ABC Incremental - If ABC Incremental is selected
as the CADlabel format, the Label tool will create
character labels which automatically increment
according to the text settings in the CADlabels
palette. To create an incremental label, first use the
CADlabels palette to set the appearance of the label
extension, label shape, and the letter of the next
incremental label you plan to draw. Then select the
Label tool and position the cursor where you want
the label terminator to end. Click and drag to posi-
tion the incremental label. Hold down the shift key
while dragging to constrain the tool to multiples of
45°, Hold down the control key while you are drag-
ging to toggle the placement of the label text.

invisible linking
point at the
base of each
label determines
its location
when updated

8]

V) A

click and drag and
the letter or number
will increment
according to the
CADlabels palette

leader length

N

-

Labeling: Tools (cont.)

123 Incremental - If 123 Incremental is selected

as the CADlabel format, the Label tool will create
numeric labels which automatically increment ac-
cording to the text settings in the CADlabels palette.
Follow the ABC Incremental instructions for creat-
ing 123 Incremental labels. To change the value of
labels created with the Incremental label tool, change
the format to Custom text or edit the label text with
Hlustrator's Type tool.

Custom text - If Custom text is selected as the
CADlabel format, the Label tool will create a text
label with "Custom" highlighted as the default value.
Important: After editing custom dimension text,
deselect the dimension to save the changes.

If you have created 'live' labels (by checking Create
live dimensions in the CADdocument palette), you
can adjust the length and angle of the label while
maintaining the link to its artwork. Use the CADtools
Dimension Resize tool to select and adjust live labels.
If you want to edit the label with Illustrator tools,
ungroup the label to unlink it and prevent updating.

Once the label is created, use the Border slider
in the CADlabels palette to adjust the shape
surrounding the CADlabel value.

008
CADlabels ~ >

Leader length: (36 |pt

f
Format: | Custom text e Next
Border:
Tight 1 Loose
{1
[m]
1 1
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Labeling: Tools (cont.)

Datum Feature

To create a datum feature, first use the CADlabels
palette to set the letter of the next datum feature
you plan to draw. Then select the Datum Feature
tool and position the cursor where you want the
terminator to end. Click and drag to position the
datum feature. Hold down the shift key while drag-
ging to constrain the tool to multiples of 45°. Hold
down the control key while you are dragging to
toggle the placement of the label text.

Use the CADtools Dimension Resize tool to select
and adjust the label.

Datum Target

To create a datum target, select the Datum Target
tool and position the cursor where you want the
terminator to end. Click and drag to position the
datum target. Hold down the shift key while drag-
ging to constrain the tool to multiples of 45°. Hold
down the control key while you are dragging to
toggle the placement of the label text. The datum
target will always be created with “1” and “A” text.
To adjust the angle of the label while maintaining
the link to its artwork, use the CADtools Dimension
Resize tool to select and adjust the label. To change
the text, use the Illustrator text tool to select and
edit the type.

Datum Flag

To create a datum flag, first use the CADlabels pal-
ette to set the letter or number of the next datum
flag you plan to draw. Then select the Datum Flag
tool and position the cursor where you want the
terminator to end. Click and drag to position the
datum feature. Hold down the shift key while drag-
ging to constrain the tool to multiples of 45°. Hold
down the control key while you are dragging to
toggle the placement of the label text.
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Labeling: Tools (cont.)

Revision Bubble

The Revision Bubble tool allows you to automati-
cally encircle artwork or drag to make revision
bubbles.

¢ To automatically encircle objects with a revision
bubble, select the revision bubble tool and position
the cursor over artwork or text path. Click once to
create the bubble.

Note: Revision bubbles created in this manner will
be linked to the encircled object. If the object is
moved and Update Links is clicked, the bubble will
redraw around the object in its new location.

¢ To create your own revision bubble, position the
cursor where you want a corner of the bubble to
appear. Click and drag from one edge of the bubble
to the opposite edge. Hold down the shift key
while dragging to create a circular revision bubble.
Hold down the control or alt/option keys to adjust
the bubble appearance.

Section Line

To create a section line, first use the CADlabels
palette to set the letter or number of the next
section line you plan to draw. To automatically
double the stroke weight of the section line, check
the Double section weight option in the CADstyle
palette. To automatically add a prime symbol to
the section line text, check the Prime section
option in the CADstyle palette. Select the Section
Line tool and position the cursor where you want
the beginning of the line to appear. Click and drag
to position the line, then release the mouse button
to create the line. Hold down the shift key while
dragging to constrain the tool to multiples of 45°.
To toggle the direction of the section line label,
hold down the control key while dragging.
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Precision control with CADtracker

CADtracker helps you monitor and edit object information
with four panels. The units and precision of the values dis-

played in the CADtracker palette c

an be changed with the

Units and Precision fields at the bottom of the palette.

Units: | cm }#i
Precision: | 0.000 |-%
Geometry

Units and Precision

for CADtracker display
are located at the bottom
of the CADtracker palette

The Geometry panel displays width, height, circumference,
perimeter, area, angle, and line length of objects - including

points and placed images.
20

| CADtracker

O

Geometry
. -37.500 em s 75.000 em

Yy 37.500 cm H: 75.000 cm
2
Length:
Perim:  300.000 cm
Area: 5625.001 cm =sq

Using CADtracker Geometry
while you are drawing...

X: Horizontal distance of cursor from
0 pt on the ruler

Y: Vertical distance of cursor from
0 pt on the ruler

W: Horizontal width of the artwork
H: Vertical height of the artwork

5+ Angle between the first click
point and the curent mouse location

Length: Distance between the first
click point and current mouse location

Radius: Radius of circle or arc
Diameter: Diameter of circle
Perimeter: Distance around a path

Circumference: Distance around a
circular path

Arc Length: Distance around the
circular arc between two endpoints you
have defined

Area: Area of rectangles, ellipses and
arc (show area in acres using CADtracker
popout menu)

Using CADtracker Geometry
with artwork selected...

X: Horizontal distance of top left
corner of object from 0 pt

Y: Vertical distance of top left corner
of object from 0 pt

W: Horizontal width of artwork
H: Vertical height of artwork
Length: Total distance along path(s)

Perimeter: Total distance around
closed path(s)

Area: Total area inside closed path(s)
or inside compound path(s).

Area calculations will not be accurate
for compound paths which overlap or
compound paths which are projected
in axonometric view:

accurate area inaccurate area

Precision control with CADtracker (cont)

Transform
CADtracker's Transform panel allows you to
numerically resize a selected object in scale.

Transform

§E§ ><:||:|.|:u:u:|cn-. | W |?5.EIEIEI¢n'| |

v:|0000cm | H:|75.0000m |

2o [ B 2 Constrain

I:' Copy 1'| [_'-Transfa-rm 1‘|

Select an object or set of objects and enter values in the
Transform panel (you can enter digits with up to five
decimal places in text boxes).

¢ To change an object’s horizontal location, enter a
value in the X text box.

¢ To change an object’s vertical location, enter a value
in the Y text box.

e To change the width of a selection’s
bounding box, enter a value in the W text box.

¢ To change the height of a selection’s bounding box,
enter a value in the H text box.

e To rotate a selection, enter a new angle between 0
and 360 degrees in the Angle text box, or choose a
value from the popup menu.

e To Constrain proportions of the transformed object,
check Constrain.

e To select the reference point from which you are
modifying the selection, click a handle on the square
representing the object’s bounding box.

Click the Transform button to transform the selected
objects. Click the Copy button to make a transformed
copy of the artwork.
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Precision control with CADtracker (cont)

Move
CADtracker's Move panel allows you to numerically
move a selected object in scale.

Mowe
43: 0000 cm  |Dist: [0.000 em |

é.‘r':|I:I.EIIIIIIIcm |ﬁ:|n° I'lj
f Copy 1‘| 7 Move L ]

Select points or objects and enter options in the
Move panel (you can enter digits with up to five
decimal places in text boxes).

¢ To move an object along the horizontal axis,
enter a value in the X text box.

¢ To move an object along the vertical axis,
enter a value in the Y text box.

¢ To move an object a distance along a rotated
axis, first enter a value in the Distance text
box. Enter a value for the rotation of axis in
the angle text box, or choose a value from the
popup menu. Click the Move button to move the
selected points or objects.

Click the Move button again to continue moving
the objects as needed. Click the Copy button to
make a copy of the artwork and move it.

Precision control with CADtracker (cont)

Repeat

The Repeat panel allows you to numerically duplicate
selected objects in rows and columns with scaled
values.

Repeat

& Rows: |0 Space: |0.000 cm
qe Cols: |0 Space: |0.000 e

Between: | Centers I:] { Repeat

Select an object and enter options in the Repeat panel.

e To duplicate objects on a horizontal path, enter the
number of Rows in the Rows text box. Use the direc-
tional arrows to repeat up or down and left or right.

¢ To create space between the rows of duplicated
objects, enter the actual value in the Space text box

on the right of the Rows text box. The artwork will be
created according to the scale set in your CADdocument
palette.

e To duplicate objects on a vertical path, enter
the number of Columns in the Cols text box.

e To create space between the columns of duplicated
objects, enter the actual value in the Space text box
on the right of the Columns text box. The artwork
will be created according to the scale set in your
CADdocument palette.

¢ Use the Between menu to set the spacing between
edges or centers of the selected objects.

Click the Repeat button to repeat the selected objects.
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2D CAD editing tools

CAD editing tools modify existing artwork with a high
level of control and precision. Only the Dimension Resize
tool is limited to CADtools artwork. And the Measure Scale
tool is very useful for calculating a scale for imported
artwork or objects that have a known actual size

without scale.

=]

Editing tool group:

Dimension Resize - Click and drag a dimension to change
the distance from the object it measures.

Fillet - Click on a line segment near a corner, then click
anywhere on the adjacent segment and enter the fillet
radius in the dialog box. Use the alt/option key while
clicking to create additional fillets with the same radius.
Chamfer - Click on a line segment near a corner, then
click anywhere on the adjacent segment and enter the
chamfer offsets from the corner in the dialog box. Use the
alt/option key while clicking to create additional chamfers
with the same offsets.

Trim - Click the excess portion of one of two intersecting
lines to remove it, or click on a line to remove the distance
to its closest endpoint.

Extend - Click on a line, then click on any line or object
which can be intersected by an extension of the line to
extend it.

Path Divider - Click on a path, then choose from options
in the Path Divider dialog box to divide and/or mark the
path into measured segments with points or crosshairs.
Measure Scale - Click the first point from which to mea-
sure and drag to define the scaled distance. In the custom
scale dialog box that appears, enter a scaled distance that
represents the actual distance you dragged. The document
scale will change based on this new equation, and the new
scale will be added to the CADdocument popup menu.

first
click

second
click

2D CAD editing tools (cont.)

Dimension Resize

The Dimension Resize tool allows you to change
the distance between a dimension and the object
it measures while maintaining the link.

Note: Dimension changes made with any other
tool will not be retained when dimensions are updated
with the Update links button.

Select the Dimension Resize tool and position the
cursor over the label or dimension line which you
plan to resize. When the ( -~ ) cursor appears, click
and drag to adjust the dimension. Use the shift key
while dragging to place dimension lines at a consis-
tent distance from the object. This offset distance is
defined in the Snap text box in the Dimension lines
panel of the CADstyle palette. To unlink a dimension
from the object it measures, select and ungroup the
dimension.

Fillet

The Fillet tool allows you to create a fillet between
two intersecting lines or a corner. The fillet radius is
defined by the last value used in the numeric input
dialog box.

Select the Fillet tool and position the cursor over one
of two intersecting lines which you plan to fillet.
When the ( -~ ) cursor appears, click once on the
line, then position the cursor over the second inter-
secting line. When the ( ;i ) cursor appears, click
once on the second line to open the numeric input
dialog box. Enter the fillet radius value to create the
radius.

_LII"- Note for creating multiple
fillets: To automatically
create additional fillets

with the same radii, use the
alt/option key while clicking
on the adjacent line.
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2D CAD editing tools (cont.)

Chamfer

The Chamfer tool allows you to create a chamfer
between two intersecting lines or a corner. The
chamfer length is determined by the distance
between the chamfer endpoints and the corner or
intersection.

Select the Chamfer tool and position the cur-

sor over one of two intersecting lines which you
intend to chamfer. When the (-~ ) cursor appears,
click once on the line, then position the cursor
over the second intersecting line. When the

(i ) cursor appears, click once on the second
line to open the numeric input dialog box. Enter
the chamfer offset values to create the chamfer.

Note for creating multiple chamfers: To auto-
matically create additional chamfers with the same
offset values, use the alt/option key while clicking
on the adjacent line.

Trim

The Trim tool will automatically delete the excess
portion of an intersecting path or the distance
between the click point and the closest endpoint.
For intersecting paths, select the Trim tool and
position the cursor over the excess portion of the
line. When the ( -i- ) cursor appears, click once on
the line to remove the distance to the intersection.
For nonintersecting paths, select the Trim tool and
click the path where you want to trim it.

To trim multiple lines at once, select the Trim tool
and click-drag over the excess portions of lines to
trim. They will trim to the nearest intersecting
line or at the click-drag point if there is no
intersection.

Note about trimming: To create trim points along
the path without deleting the artwork, double-click
the Trim tool and set the tool preferences.

-~

4

click once to Vi
trim the line

to the nearest
intersection ’

/

to trim the /

click once
excess of

a single line ’
/
drag over a
set of lines
to trim their
excess or
portions to
the nearest
intersection

/

1
1
A

/
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N
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click once on the
line and then on
the path to extend

click and drag
the distance
from which to
measure

2D CAD editing tools (cont.)

Extend

The Extend tool will automatically extend a path to
meet another path. Select the Extend tool and po-
sition the cursor over the path you want to extend.
When the ( =i ) cursor appears, click once on the
path, then click the path to which you want to ex-
tend. Note: The two paths must be able to intersect.

Path Divider

The Path Divider tool allows you to precisely divide
a path in sections or in specified increments from
beginning, middle or end. Divisions can be marked
with anchor points and crosshairs and cut into
paths. Select the Path Divider tool and click on the
path you want to divide. Use the dialog box to set
the options for division.

Path Divider

~Divide Path

f 0K )
®in '121—| equal sections
O In increments of |1,000" | from Middle

~Options
(0 Add anchor points
@ Cut into separate paths

EAdd crosshairs

Measure Scale

The Measure Scale tool allows you to set a custom
scale based on a representative actual distance.
Measure Scale works much like a legend on a map.
Select the Measure Scale tool and click the first
point from which to measure. Drag to define the
scaled distance. In the custom scale dialog box that
appears, enter a scaled distance that represents
the actual distance you dragged. The current scale
will change based on this new equation, and the
new scale will be added to the CADdocument popup

menu.
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Isometric drawing: CADisometric palette

There are multiple ways to create and edit isometric
artwork with CADtools. You can project flat artwork to
top, front, or side planes, or you can draw isometric art-
work with the CADisometric drawing tools. Both of these
methods produce artwork that can be dimensioned with
CADisometric dimensioning tools.

Note: You may want to copy your artwork or save a copy
of your document before you start projecting artwork —
especially if you need to preserve your 2D artwork.

The CADisometric palette helps you project flat artwork
in isometric view and control the appearance of isometric
artwork. Use the preset menu to choose from existing
views, or create your own custom view by rotating the
cube icon or using the 2D and 3D angle field values.
Before rotating the cube icon, unlock it by clicking on
the locked icon. Lock the view into place to prevent
changes to the view.

20
| CADisometric | CADtracker ', [F) Hide options

- s Add custom view... .
——T., Fatten Expand e
- Remove custom view

cellills
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Isometric projection - To project 2D artwork on to isometric
planes, first draw artwork flat inside Adobe Illustrator. Use
CADtools drawing tools if you need to create the artwork in
scale. Dimensions can also be projected with the artwork.

For creating 3-sided object views, draw top, front, and side

in this arrangement.

TOP

FRONT SIDE

click the face on
the cube icon in
the CADisometric
palette to project
artwork on that
plane

hold the alt/option
key down when
projecting artwork
with the cube icon
to automatically
expand it

Isometric drawing: CADisometric palette

Select the pieces of artwork that comprise one plane -
choose Object > Group. Select each set of grouped artwork
and click the corresponding plane on the icon in the CAD-
isometric palette. If you create 2 or 3 views to project,
arrange the artwork prior to projection as shown below:

For bottom views:

front | side projected

e

bottom

For top views:

top projected

e

front side

O O

If you want the artwork to project on the same plane,
remember to group the artwork before projecting.
(Or————)  projected Q H

- =

Grouped artwork
C C projected Q\D

—>

Note: If you ungroup artwork that was projected as a
group, the artwork will not be live or able to flatten.

Ungrouped artwork

/

f —

Once you've projected artwork with the CADisometric
palette, you can adjust the view angles to change the
artwork's appearance. First, unlock the cube icon by
clicking on the lock icon. Then click and drag to rotate
the cube icon to freely change the appearance of
projected shapes on your document. Or you can
numerically adjust the angles of projection with

the 2D and 3D fields in the CADisometric palette.
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Isometric drawing: CADisometric palette

Important to prevent exploded artwork: Do not rotate,
shear, reflect, or modify projected isometric artwork
unless it is first expanded.

Flatten to edit projections in 2D - If you need to edit the
projected isometric artwork, select the artwork and click the
Flatten button in the CADisometric palette. After you have
made changes, click on the faces of the cube icon to reproject
the artwork as top, front, and side planes.

Expand to edit projections in 3D - If you want to edit the
artwork directly in isometric view, you should select and Expand
the artwork to avoid unexpected reshaping or 'exploding.' Use
the Expand button located in the CADisometric palette to remove
all internal links between the selected artwork and CADisometric
settings. Some filters and tools such as Illustrator's gradient
mesh will automatically expand the artwork and disable its 'live'
attributes. Dimensions cannot be made on expanded artwork - be
sure to finish all tasks related to measurement and adjustment
before artwork is expanded.

Hot Tip!

To save time, start with a simple isometric cube and use it to set
your desired view angles before creating isometric artwork. Then
lock the view in the CADisometric palette to prevent changes.

Isometric drawing - You can easily create isometric vector

artwork with CADtools isometric drawing tools. The cube icon in
the CADisometric palette indicates the face you are drawing. The
default face is the front/left side. Drag with cmd/cntrl to create
side/right side. Drag with alt/option to create top/bottom sides.

You will also see helpful cursor hints for snapping and alignment.

For example, when the top corner of the side face aligns with the
top of the front face, the cursor hint will appear - 'aligns with
front.'

aligns with side

ialigns with front

Likewise, when you start dragging a top face from the
corner point of a front or side, you will be able to see
helpful cursor hints for aligning the top. When the cursor
changes to (M. ), you are over a corner point. The tolerance
for face snapping is the same as the snap to grid tolerance
in the CADguides palette.

' Flatten 3

f Expand N

Isometric drawing: Tools
0

el |0 @ |# ;|8

Isometric (axonometric) drawing tool group:
Use the following keys to create front, side or hori-
zontal faces with the CADisometric drawing tools:

Front (or left side) vertical faces: No modifier key
Side (right) vertical faces: Hold down the
command key (Mac) or control key (Windows)

after you begin dragging

Top/bottom faces: Hold down the alt/option key
after you begin dragging with the tool.

Isometric Rectangle - Click and drag to create the
shape according to settings in the CADisometric
palette.

Isometric Centered Rectangle - Click and drag to
create the shape from its center.

Isometric Ellipse - Click and drag to create the
shape.

Isometric Centered Ellipse - Click and drag to cre-
ate the shape from its center.

Isometric Grid - Click and drag to create a grid
based on the settings in the CADguides palette.
Isometric Cube - Click and drag to create the front,
side or top face (with control/command key for side
or alt/option for top or bottom). After releasing
the mouse, drag perpendicular to the side to create
depth. (You do not need to hold down any modifier
keys while dragging the depth of the cube.) When
the desired depth is reached, click the mouse to fin-
ish creating the cube.

Isometric Cylinder - Click and drag to create the
front, side or top face (with control/command key
for side or alt/option for top or bottom). After
releasing the mouse, drag perpendicular to the side
to create depth. (You do not need to hold down any
modifier keys while dragging the depth of the
cylinder.) When the desired depth is reached,

click the mouse to finish creating the cylinder.
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Isometric drawing: Tools (cont.)

Isometric Rectangle

Select the Isometric Rectangle tool and position
the cursor where you want a corner of the rect-
angle to appear. Click and drag from one edge of
the rectangle to the opposite edge. To draw a front
face rectangle, click and drag to the opposite edge.
To create a side face, hold down the command/
control key after you begin dragging. To create a
top or bottom face, hold down the alt/option key
after you begin dragging. (Bottom faces can only
be created if your isometric view is rotated so that
the bottom view is showing.) Hold down the shift
key to create a square in isometric view. The cube
icon in the CADisometric palette indicates which
face you are drawing.

To numerically create the rectangle, click once on
the document. The click point will become the top
right corner of a front face, the top left corner of a
side face, and the bottom corner of a top face.

Isometric Centered Rectangle

This tool works just like the Isometric Rectangle
tool, except that the initial click point becomes
the center of the isometric rectangle.

Isometric drawing: Tools (cont.)

Isometric Ellipse

Select the Isometric Ellipse tool and click and drag
from one edge of the ellipse to the opposite edge.
The cursor is located at the corner of the bounding
box of the ellipse - not actually on the ellipse path.
To draw a front face ellipse, click and drag to the
opposite edge. To create a side face, hold down the
command/control key after you begin dragging. To
create a top or bottom face, hold down the alt/
option key after you begin dragging. (Bottom faces
can only be created if your isometric view is rotated
so that the bottom view is showing.) Hold down the
shift key to create a circle in isometric view. The
cube icon in the CADisometric palette indicates
which face you are drawing.

Isometric Centered Ellipse

This tools works just like the Isometric Ellipse tool,
except that the initial click point becomes the cen-
ter of the isometric ellipse.
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Isometric drawing: Tools (cont.)

Isometric Grid

Select the Isometric Grid tool and position the
cursor where you want a corner of the grid to
appear. Click and drag from one edge of the grid
to the opposite edge. Hold down the shift key
while dragging to create a square grid.

Isometric Cube

Select the Isometric Cube tool and click and drag
a front, side, or top face just as you would draw
an isometric rectangle. After releasing the mouse,
immediately drag along the isometric angle
without clicking to preview the cube depth. When
the desired depth is reached, click the mouse to
create the cube according to the current isomet-
ric view angle. Cubes are automatically grouped
when created. Remember to finish creating

the cube depth before deleting, undoing or
choosing another tool.

Single-click on the document to create a cube
numerically. The cube’s central 'home point' will
be placed at your click point.

Isometric Cylinder

Select the Isometric Cylinder tool and click and
drag a front, side, or top face just as you would
draw an isometric circle. After releasing the
mouse, immediately drag along the isometric
angle without clicking to preview the cylinder’s
depth. When the desired depth is reached, click
the mouse to create it. The exact drag point (top
or bottom) differs based upon how the cylinder
was created. Cylinders are automatically grouped
when created. Remember to finish creating the
cylinder depth before deleting, undoing or
choosing another tool.

Single-click on the document to create a cylinder
numerically. The cylinder face’s center point will
be placed at your click point.

S
home point

2

Isometric dimensioning: Tools
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Isometric dimension tool group:

Horizontal Isometric Dimension (By Line) Click
and drag out any horizontal segment projected in
isometric view to dimension the distance between
two anchor points.

Horizontal Isometric Dimension (By Points) Click
multiple horizontal points in isometric view and
drag to dimension the distance between two anchor
points.

Horizontal Isometric Datum Dimension Click a
point of origin, then click multiple horizontal points
in isometric view and drag to dimension the distanc-
es from the origin.

Vertical Isometric Dimension (By Line) Click and
drag out any vertical segment projected in isometric
view to dimension the distance between two anchor
points.

Vertical Isometric Dimension (By Points) Click
multiple vertical points in isometric view and drag to
dimension the distance between two anchor points.
Vertical Isometric Datum Dimension Click a point
of origin, then click multiple vertical points in
isometric view and drag to dimension the distances
from the origin.

Isometric Diameter Dimension - Click and drag a
point on an isometric circle to dimension its
diameter.

Isometric Radius Dimension - Click and drag a
point on an isometric circle to dimension its radius.
Isometric Center line - Shift-click and drag to
create the line in isometric view.

Isometric Object center - Click on an object

line to mark the center of its bounding box

in isometric view.
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Isometric dimensioning: Tools (cont.)

Horizontal Isometric Dimension (by Line)

The Horizontal Isometric Dimension (by Line) tool will
dimension horizontal line segments in isometric view.
A line segment is a straight path between two anchor
points in Illustrator.

Select the Horizontal Isometric Dimension (by Line)
tool and position the cursor over the line you want to
dimension. When the ( -i> ) cursor appears, click the
horizontal line and drag to position the dimension
line. Hold down the shift key while dragging to

offset the dimension line in increments. The offset
increment value is set in the Snap field in the
Dimension lines panel of the CADstyle palette.

Hot Tip! Hold down the cmd/control key to create
dimensions perpendicular to the isometric object.

Horizontal Isometric Dimension (by Points)
The Horizontal Isometric Dimension (by Points) tool
will dimension the horizontal distance between
multiple points in isometric view. You can define the
location of these points anywhere on your document.

Select the Horizontal Isometric Dimension (by Points)
tool and position the cursor at one end of the hori-
zontal distance you want to dimension. If this is an
anchor point, the cursor will change to ( -i3 ) . Then
click the mouse button once and release the mouse
button. Position the cursor at the next point along
the horizontal distance you want to dimension. Con-
tinue clicking on points along the horizontal distance
until you have reached the last point to dimension.
Then click the last point and drag to position the
dimension line. Use the shift key while dragging to
place the dimension line at a set distance from the
object. The offset increment value is set in the Snap
field in the Dimension lines panel of the CADstyle
palette. Hold down the control key to create
dimensions perpendicular to the isometric object.

o

click once
on a line segment
and drag

drag with the
control key to
create perpendicular
dimensions

e

click on multiple
points and drag

drag with the
control key to
create perpendicular
dimensions

il

click on multiple
points and drag

drag with the
control key to
create perpendicular
dimensions

Isometric dimensioning: Tools (cont.)

Horizontal Isometric Datum Dimension

The Horizontal Isometric Datum Dimension tool
will dimension the horizontal distances between

a point of origin and other points in isometric view.

Select the Horizontal Isometric Datum Dimension tool
and position the cursor at the origin on one end of
the horizontal distance you want to dimension.

If this is an anchor point, the cursor will change

to ( -i3.) . Then click the mouse button once and
release the mouse button. Position the cursor at the
next point along the horizontal distance you want

to dimension. Continue clicking on points along the
horizontal distance until you have reached the last
point to dimension. Then click the last point and drag
to position the dimension line. Use the shift key while
dragging to place the dimension line at a set distance
from the object. The offset increment value is set in
the Snap field in the Dimension lines panel of the
CADstyle palette. Hold down the control key to create
dimensions perpendicular to the isometric object.

To make a datum dimension line appear as a linear
chain of dimensions rather than stacked dimensions,
check Chain datum in the CADstyle palette.

To change the datum dimension terminator to
a JIS terminator, check Chain datum and JIS
terminator in the CADstyle palette.

Note: For accurate measurements, make sure the
artwork is arranged properly on one plane - to check
this, flatten the artwork, adjust as needed, then group
before reprojecting it. If the artwork is properly
constructed, isometric dimension values should not
change when the artwork and dimensions are flattened.
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Isometric dimensioning: Tools (cont.)

Vertical Isometric Dimension (by Line)

The Vertical Isometric Dimension (by Line) tool will
dimension vertical line segments in isometric view.
A line segment is a straight path between two
anchor points in Illustrator.

Select the Vertical Isometric Dimension (by Line) tool
and position the cursor over the line you want to
dimension. When the ( =iz ) cursor appears, click the
vertical line and drag to position the dimension line.
Hold down the shift key while dragging to

offset the dimension line in increments. The offset
increment value is set in the Snap field in the
Dimension lines panel of the CADstyle palette.

Hold down the control key to create dimensions
perpendicular to the isometric object.

Vertical Isometric Dimension (by Points)

The Vertical Isometric Dimension (by Points) tool will
dimension the vertical distance between multiple
points in isometric view. You can define the location
of these points anywhere on your document.

Select the Vertical Isometric Dimension (by Points)
tool and position the cursor at one end of the vertical
distance you want to dimension. If this is an anchor
point, the cursor will change to ( -iz ) . Then click
the mouse button once and release the mouse button.
Position the cursor at the next point along the verti-
cal distance you want to dimension. Continue clicking
on points along the vertical distance until you have
reached the last point to dimension. Then click the
last point and drag to position the dimension line.
Use the shift key while dragging to place the dimen-
sion line at a set distance from the object. The offset
increment value is set in the Snap field in the Dimen-
sion lines panel of the CADstyle palette. Hold down
the control key to create dimensions perpendicular to
the isometric object.
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Isometric dimensioning: Tools (cont.)

Vertical Isometric Datum Dimension
The Vertical Isometric Datum Dimension tool

i il

click once click on multiple ~ Will dimension the vertical distances between
g;‘dadlgg segment points and drag a point of origin and other points in isometric

view.

Select the Vertical Isometric Datum Dimension tool
and position the cursor at the origin on one end of
the vertical distance you want to dimension.
If this is an anchor point, the cursor will change
to (-7, ) . Then click the mouse button once and
release the mouse button. Position the cursor at the
drag with the next point along the vertical distance you want to
control key to dimension. Continue clicking on points along the
create perpendicular vertical distance until you have reached the last
dimensions point to dimension. Then click the last point and
drag to position the dimension line. Use the shift
key while dragging to place the dimension line at a
set distance from the object. The offset increment
value is set in the Snap field in the Dimension lines
panel of the CADstyle palette. Hold down the con-
trol key to create dimensions perpendicular to the
isometric object.

drag with the
control key to
create perpendicular
dimensions

25

click on multiple
points and drag

To make a datum dimension line appear as a linear
chain of dimensions rather than stacked dimen-
sions, check Chain datum in the CADstyle palette.

To change the datum dimension terminator to
a JIS terminator, check Chain datum and JIS
terminator in the CADstyle palette.

drag with the
control key to
create perpendicular
dimensions

Note: For accurate measurements, make sure the
artwork is arranged properly on one plane - to check
this, flatten the artwork, adjust as needed, then
group before reprojecting it. If the artwork is prop-
erly constructed, isometric dimension values should
not change when the artwork and dimensions are
flattened.
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Isometric dimensioning: Tools (cont.)

Isometric Diameter Dimension

Select the Isometric Diameter Dimension tool
and position the cursor over the path of an
isometric circle. When the ( =it ) cursor ap-
pears, click and drag to position the diameter
dimension. Hold down the shift key while drag-
ging to constrain the tool to isometric multiples
of 45°. Hold down the control key while you
are dragging to toggle the placement of the
diameter dimension text.

Isometric Radius Dimension

Select the Isometric Radius Dimension tool

and position the cursor over the path of an
isometric ircle. When the ( =iz ) cursor appears,
click and drag to position the radius dimen-
sion. Hold down the shift key while dragging

to constrain the tool to isometric multiples of
45°, Hold down the control key while you are
dragging to toggle the placement of the radius
dimension text.

Note: To quickly toggle between radius dimension
and diameter dimension, use the alt/option key.

9—[!

click on the
circle path

and drag
v
£
click on the
circle path
and drag
v

click and
drag

click on an
object path

Isometric dimensioning: Tools (cont.)

Isometric Center Line

The Isometric Center Line tool will allow you to
create a center line that constrains to the current
isometric angles. Select the Isometric Center Line
tool and position the cursor where you want the
beginning of the line to appear. Click and drag to
position the line, then release the mouse button

to create the line. Hold down the shift key while
dragging to constrain the tool to the current isomet-
ric view angles (set in the CADisometric palette).

Isometric Object Center

Select the Isometric Object Center tool and position
the cursor over the path of a circle or object. When
the (-i-) cursor appears, click once and release
the mouse button to create the object center in

isometric view.
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Quick Reference: Numeric input

Using numeric input

You can create artwork to scale by numerically speci-
fying dimensions for CADtools drawing tools. Select
the tool and click once where you want to begin
creating the shape. If you are using a centered tool,
your click location will define the center of the object;
otherwise, the click location will define a corner of
the object. A numeric input dialog box will appear,
displaying the dimensions you last specified for that
tool.

You can use the following unit abbreviations:

1) Points: pt

2) Picas:p

3) Millimeters: mm

4) Centimeters: cm

5) Meters: m

6) Kilometers: km

7) Decimal inches with symbol: X.X*

8) Fractional inches with symbol: X X/X”

9) Decimal inches with units: X.X in

10) Fractional inches with units: X X/X in

11) Decimal feet and inches with symbol: X' X.X*
12) Fractional feet and inches with symbol: X' X/X”
13) Decimal feet and inches with units: X ft X.X in
14) Fractional feet and inches with units: X ft X/X in
15) Miles: mi

Note: If you do not specify a unit, the artwork will
be drawn in the units specified in the CADdocument
palette.

\45°

angle dimensioning
without the control key

45°

angle dimensioning
with the control key

Quick Reference: Keyboard shortcuts

Keyboarding for precision and shortcuts
CADtools utilizes the shift, alt/option, and control
keys to give you more control and flexibility while
drawing and dimensioning. Note: these keys only
function if you hold them down after you select and
begin drafting or dimensioning with one of the tools.

Use the shift key to constrain most CADtools 2D
drafting and dimensioning tools to multiples of 45°.

To quickly switch between certain tools in CADtools,

use the alt/option key (alt for PC and option on

Mac) while dragging to toggle between the following

2D and isometric tools:

1) Rectangle and Centered Rectangle

2) Ellipse and Centered Ellipse

3) Arc (by radius) and Arc (by endpoints)

4)Horizontal Dimension by Point and Vertical
Dimension by Point

5) Horizontal Dimension by Line and Vertical
Dimension by Line

6) Horizontal and Vertical Datum Dimension

7) Radius and Diameter Dimension

8) Tangent Dimension: Shows normal line

Use the control key for variations in dimensioning
artwork. The control key provides the following tool
variations:

1) Arc: complementary arc

2) Section Line: adjacent placement of label

3) Angle Dimension: complementary angle

4) Arc Length Dimension: complementary arc length
5) Diameter Dimension: adjacent placement of label
6) Radius Dimension: adjacent placement of label
7)Bézier Curvature Dimension: arc visibility

8) Tangent Dimension: placement of normal line

9) All label tools: adjacent placement of label

To remove witness lines while drawing angle
dimensions, use the alt/option key while
dragging with the angle dimension tool.

Hold the alt/option key down when projecting artwork
with the cube icon to automatically expand it.

63



64

Cursor description Activity status

- Precision cursor CADtools drawing, editing, dimensioning

. Cursor dragging

Quick Reference: Cursor feedback

Cursor feedback

While you are drawing and dimensioning with CAD-
tools, you will receive additional precision cursor
feedback to help you select lines and anchor points
in the correct order.

or labeling tool is selected

- Precision cursor Tool is selected and cursor is directly over a path
over path

~. Precision cursor Tool is selected and cursor is directly over an anchor
over anchor point point

= Precision cursor Tool is selected, you have already clicked once, and

waiting for second click  you need to click or click-drag to create artwork

to create artwork you are dragging
© Cursor over You are directly over a dimension line. You will not
dimension line be able to create a dimension when this cursor
appears.

Tool is selected, you have clicked once or twice, and

Dimensioning objects

When dimensioning by points, be sure to use the
precision cursor over the anchor points to properly
dimension the object. Inaccurate measurements will
result if the dimensions are pulled from the lines
rather than the anchor points.

Advanced topics

Saving artwork
You must save artwork in Illustrator 10 or higher
format or the dimension information will be lost.

Importing or exporting artwork

Adobe Illustrator 9 and above includes DXF and
DWG import and export features. Once a file is
imported as vector artwork inside Adobe Illustrator,
CADtools can be used to dimension or edit the art-
work. In some cases, an imported file may contain
artwork comprised of small line segments. Dimen-
sioning tools by line, as well as radius, diameter,
arc length, and Bézier curvature dimensioning tools
will not work for such segmented artwork. To
connect these DXF line segments, use the
Concatenate filter available at (http://rj-graffix.
com/) For more information on opening or placing
files within Illustrator, please refer to the Adobe
Illustrator User Guide, technical notes, and Adobe
web site at (www.adobe.com).

Adobe Acrobat 7 now includes an AutoCAD plugin
to write PDF files from AutoCAD 2002, 2004, and
2005. Please visit the Adobe Web site for more info.

Other software programs offer some control of

CAD file translation. Applicraft’s CADgate is an
Illustrator plug-in that supports the transfer of
CADtools dimensions when importing and exporting
(www.hotdoor.com/CADgate/). CADMover is a
popular stand-alone translation product made by
Kandu Software (www.kandusoftware.com)

Symbol and pattern libraries

Hot Door CADpatterns offers 134 patterns for
technical drawing. Code Zebra makes a compre-
hensive set of symbols in seven categories: Archi-
tecture, Building Services, Landscaping, Electrical,
Mechanical, Fasteners and General. Purchase the
entire set or separate libraries at (www.hotdoor.
com). Check the Hot Door Web site for updates on
new products as they become available.
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Advanced topics (cont.)

Serial number saving problems

Your serial number may not save properly if your Illustrator
Preferences file has been corrupted. To delete your Preferences
with Illustrator CS/CS2, relaunch Illustrator and immediately
press the following key combination: command + option +
shift (Mac), or control + alt + shift (Windows). Then click

Yes to delete your settings. With older Illustrator versions on
Macintosh, throw away the Adobe Illustrator Preferences file
found in the Preferences folder in the System folder. On Mac
0S X platforms, the Preferences file is found in the Home >
Library > Preferences folder. On Windows, perform a file search
for the 'AI Prefs' file and delete it.

Using Illustrator's Smart Guides

Adobe Illustrator includes Smart Guides that
help you create, align, edit, and transform
objects. Smart Guides works with CADtracker,
CADgrids and CADrulers for optimal precision
and control when manipulating artwork.

Duplicating objects with dimensions

Any dimensions linked to objects which have been duplicated
with the alt/option-drag keys may not update correctly. To
duplicate objects with dimensions, copy and paste the objects
with their dimensions. To avoid unpredictable results, ungroup
dimensions prior to copying and pasting them into new
documents.

Drawing in the dimension layer

Your dimensions will automatically draw into a separate layer
named “Dimension Layer” if 'Create and use dimension layer'

is checked in the CADdocument palette. This Dimension layer
can be hidden, locked, displayed, and printed like other layers
created within Illustrator. All objects drawn in the dimension
layer will be 1:1 scale. Avoid using the Dimension Layer for
creating other artwork and make sure that you are working in
the appropriate layer while you are drawing.

Bézier curvature dimensioning for circles and arcs
Circles and circular arcs created within Illustrator are con-
structed with Bézier curves. Therefore, the radius at any
point of a circle or circular arc may reveal a variance of up to
5% of the original specified radius.

Advanced topics (cont.)

Using CADgrids

CADgrids and CADrulers are created as artwork in
separate locked layers. CADgrids increments are logical
divisions of the units defined in the CADguides palette.
Only CADtools drawing tools can snap to CADgrids if
Snap to grid is checked in the CADguides palette. You
cannot use CADtools to snap to Illustrator grids and
guides, and you cannot use Illustrator tools to snap

to CADgrids.

Drawing isometric objects

For best results, create a simple isometric cube before
creating artwork and adjust the view angles. Then lock
the cube icon in the CADisometric palette to prevent
accidental view changes. For separate isometric shapes
that share the same plane, first create them as flat
artwork and group them. Then project them to the
front, side, or top plane with the cube in the
CADisometric palette.

Area values for intersecting paths

The area of a path that intersects itself cannot be
calculated correctly by the CADtracker palette. Area
can be calculated for single or multiple shapes as

long as they are closed and do not include overlapping
compound paths.

Using patterns in isometric view

Patterns are not automatically transformed with
CADtools objects, but you can force a transformation
of pattern artwork by expanding and projecting it with
your flat artwork using the CADisometric palette.

Smoothing sharp isometric artwork

The geometry of isometric objects may naturally show
many sharp angles in the artwork. If you plan to stroke
the artwork, use Round Join for a cleaner appearance.
You can choose Round Join in the Options panel of the
Tllustrator Stroke palette.
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lllustrator CAD resources

Hot Door MultiPage 2

Publishing power with multiple pages
inside Adobe Illustrator

e (Create, export, and print multiple pages
and multiple page pdf files

e Use page masters to share artwork
throughout the document

e (reate or delete one or more pages and
easily set margins and page numbers

e Page navigation and thumbnails

e Turn it on or off as needed - easy!

$79 at www.hotdoor.com

Hot Door CADpatterns

134 patterns for technical illustration

Hot Door CADpatterns add 134
vector-based swatch patterns for
design documents. Swatch patterns
tile seamlessly and include:

* Stipples

Crosshatches

Bricks

Wood grains

Stone o
Tile ST L
Building Materials
And much more!

E I R . R T

589 at www.hotdoo:.co:n

Other Web links

www.architosh.com

Essential for Mac-based architects and CAD professionals
http://rj-graffix.com/

Specialized plugins for technical illustrators
www.pluginsworld.com

Info about most Adobe plugins

www.kandusoftware.com
CADMover software translates dozens of file formats
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